
 

Introduction to Cleaner 5

 

A Media 100

 

®

 

 Company

 

 

 

®



 

The Legal Stuff

 

Introduction to Cleaner 5
For Mac OS™ and Windows™

 

Copyright © 1995–2000 Terran Interactive, a wholly 

owned subsidiary of Media 100, Inc. All rights 

reserved.

The information in this manual is provided for 

informational use only and is subject to change 

without notice. Information in this manual should 

not be construed as a commitment by Terran. Terran 

assumes no responsibility or liability for any errors 

or inaccuracies that may appear in this manual. 

Discussion of products and/or technologies in this 

manual does not imply endorsement by Terran. 

Please remember that many existing movies, images, 

broadcasts and sounds are protected under 

copyright law. Using such materials in your 

multimedia projects without permission may violate 

the rights of the author and result in serious 

penalties. 

Terran Interactive, the Terran logo, Cleaner 5, Media 

Cleaner, Movie Cleaner, EventStream, 

StreamPublisher, Codec Central and Intelecine are 

all trademarks of Terran Interactive. Media 100, 

Media 100 i and iFinish are trademarks of Media 

100, Inc. MotoDV, EditDV and Cinepak are 

trademarks of Digital Origin, Inc. Sorenson Media, 

Sorenson Video, Sorenson Vision and the Sorenson 

logo are trademarks of Sorenson Vision, Inc. 

QDesign Music, QDesign and the QDesign logo are 

trademarks of QDesign Corporation. Adobe, Adobe 

Premiere, After Effects, Adobe GoLive and 

Photoshop are trademarks of Adobe Systems 

Incorporated. Apple, G3, G4, Mac OS, Macintosh, 

Power Macintosh, QuickTime, SoundManager and 

the respective Apple logos are trademarks of Apple 

Computer, Inc. Real, RealAudio, RealVideo, 

RealSystem and the respective Real logos are 

trademarks of RealNetworks Incorporated. Toast is a 

trademark of Adaptec Corporation. Pentium and 

MMX are trademarks of Intel Corporation. Indeo is 

a trademark of Ligos Technologies. Windows, 

Windows Media Technologies, Video for Windows, 

DirectShow and Microsoft’s respective logos are 

trademarks of Microsoft Corporation. 

Other brands, product names and company names 

are trademarks of their respective holders.

Tutorial movies and screen shots courtesy of:

Vertical Online,  www.verticalonline.com

Artbeats Software, Inc., www.artbeats.com 

21st Century Media, 

www.21stCenturymedia.com

Presto Studios, www.presto.com

DirectorSite, Inc., www.directorsite.com

Journeyman Digital, www.journeyman.com

eMotion Studios, www.emotionstudios.com

All tutorial movies are the property of their 

respective owners and may only be used in the 

context of the Cleaner tutorials. You may not use 

these files for any other purpose without the express 

written consent of the movie owners.

 

Part number: 22080

http://www.presto.com
http://www.verticalonline.com
http://www.directorsite.com
http://www.journeyman.com
http://www.emotionstudios.com


 

Introduction to Cleaner 5   Table of Contents                                                                       i

       
Table of Contents

Welcome
Where to start  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

Conventions used in this manual . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

What’s New in Cleaner 5
Capture . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Author  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Encode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Architectures and Formats  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Processing enhancements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8

Publish  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

Installation & System Requirements
Windows system requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Mac OS system requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Windows installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Typical Install on Windows  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Compact Install on Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Custom Install on Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Uninstalling Cleaner for Windows  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Mac OS Installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Easy Install on Mac OS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Custom Install on Mac OS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Installing MotoDV . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Installing QuickTime . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Installing RealSystem . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Installing Windows Media  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Installing the Premiere Export Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Personalizing Cleaner  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

News & Updates  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17



 

ii                                                                     Introduction to Cleaner 5   Table of Contents

      
Cleaner 5 QuickStart
Capture . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

Author  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Encode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Publish  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

Cleaner 5 Basics
General Cleaner concepts & terms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

Cleaner 5’s Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Batch window  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Project window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

Output window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

Settings Wizard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

Advanced Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

Dynamic Preview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

Settings Modifiers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

Metadata  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

EventStream Editor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

StreamPublisher  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

Preferences dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

Streaming Basics
What is streaming? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

Choosing a streaming method  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

Architectures and codecs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Architectures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Codecs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Choosing architectures and codecs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Overview of codecs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

How video codecs work . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

Codecs in action  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

Additional information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39



 

Introduction to Cleaner 5

 

Welcome

 

1

               
Thank you for choosing Cleaner 5, the tool used by the biggest and best websites to produce 

award-winning streaming media. Cleaner offers a complete camera-to-web solution that makes 

it easy to put video and audio on your site.

If you’re new to streaming, Cleaner makes it simple to get great results right out of the box. If 

you’re an experienced streamer, Cleaner gives you more control over more formats than any 

other solution. Once you use Cleaner, we’re sure you’ll see why it is the industry standard for 

streaming media production.

Where to start
Cleaner 5 has lots of new and exciting features. To explain how to use the full range of Cleaner’s 

features to capture, author, encode and publish streaming media, we’ve created a series of 

publications.

Introduction to Cleaner 5 — This booklet provides a good overview of how to use Cleaner and 

explains the basics of streaming. It also outlines what’s new in Cleaner 5 and has installation 

instructions. If you’re new to Cleaner, we recommend you get started by reading the 

Introduction to Cleaner 5 completely. If you’re an experienced user, we suggest you review the 

What’s New In Cleaner 5 section on page 5 and refer to the QuickStart section beginning on 

page 19 for a good overview of Cleaner 5.

Cleaner 5 User Manual — The User Manual explains the features and options of Cleaner in 

substantial depth. The User Manual assumes that you’ve read the Introduction to Cleaner 5, so 

we suggest you get familiar with the Introduction before digging into the User Manual. Although 

it’s not a bad idea to read the entire User Manual from cover to cover, we generally recommend 

that you mostly use the manual as a reference when needed. 

Cleaner 5 Tutorials — For step-by-step tutorials that help you learn how to use Cleaner 5 to 

create streaming media, refer to the Cleaner 5 Tutorials PDF on the Cleaner 5 CD-ROM. If you’re 

new to Cleaner or streaming media, completing the tutorials is an excellent way to learn how to 

use many of Cleaner’s features. If you’re an experienced Cleaner user, we suggest you skim the 

tutorials and do the EventStream Authoring Tutorial on page 77 to learn about this important 

new feature.
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Cleaner 5 Integration Guide — Cleaner 5 works well with many video and web creation tools, 

such as EditDV, iFinish, Media 100, Adobe Premiere, Adobe GoLive, DreamWeaver, FrontPage 

and more. To learn how to use Cleaner with these tools, please see the Integration Guide on the 

Cleaner 5 CD-ROM.

Cleaner 5 Automation Guide — Cleaner 5 offers a wide range of powerful automation features 

that enable you to build your own custom encoding solutions. For information on Cleaner’s 

automation features, including AppleScript, DCOM, Command Line and XML-based settings, 

please refer to the Automation Guide on the Cleaner 5 CD-ROM.

MotoDV User Manual — Cleaner 5 includes Digital Origin’s easy-to-use MotoDV application 

to enable you to capture high-quality DV movies. For the basics of using MotoDV with Cleaner, 

see the Capturing Your Source chapter on page 5 of the Cleaner 5 User Manual. For more 

details, you can also refer to the MotoDV User Manual PDF  on the Cleaner 5 CD-ROM.

NOTE:   All these documents can also be downloaded in Adobe PDF format from Terran’s 

website at www.terran.com/.

Conventions used in this manual
Because Cleaner’s user interface is almost identical between platforms, this manual is intended 

for both the Windows and Mac OS versions. Whenever there is a substantial difference between 

the different versions of Cleaner, we’ll note this in the text. For example, if a feature only works on 

the Mac OS, we indicate this by putting (Mac OS only) after the feature. 

The screen shots are taken from both the Mac OS and Windows versions of Cleaner, with no 

particular bias toward platform. When there is a notable difference between platforms, we show 

both and label them clearly. 

Boldface type is used to distinguish essential information, features and commands from the rest 

of the body text. See the paragraphs that follow for examples.

When we talk about menus, we’ll use the format Menu > Menu item. For example, choosing the 

Send Terran My Feedback option in Cleaner’s Internet menu is described as Internet > Send 

Terran My Feedback.

 

For commands that have keyboard shortcuts, we always show the Windows shortcut first, 

followed by the Mac OS shortcut, separated by a slash (/). For example, the keystroke for the Save 

command would be shown as (Ctrl+S / "+S). This means on Windows you would hold down 

the Ctrl key and press the S key. On Mac OS, you would hold down the Command key, which is 

labeled ", and press the S key. 
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On the Mac OS version of Cleaner, the Control key is used for contextual menus rather than 

keyboard shortcuts. For more information on this feature, see the Streamlining Your Workflow 

chapter in the User Manual.

Tell us what you think
We encourage you to contact us with any suggestions, comments or questions you may have on 

Cleaner 5. We are constantly working to improve Cleaner, and your feedback is invaluable to 

us. In fact, many of the new features in Cleaner 5 are based directly on user suggestions. To 

contact us, please choose Internet > Send Terran My Feedback to launch your web browser 

and go directly to our customer feedback page.

We hope you find using Cleaner 5 an enjoyable experience. Happy streaming!

— The Terran Team         
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This exciting new release has many new features that make it faster and easier than ever before to 

put the highest-quality streaming media on your site. 

This chapter outlines the new features and enhancements of Cleaner 5. Because there are so 

many improvements, we’ve organized them according to the basic steps in the Cleaner workflow: 

Capture, Author, Encode and Publish. We’ve also listed workflow enhancements that may apply 

to multiple aspects of Cleaner at the end of this chapter.

Capture

DV capture
Cleaner 5 supports high-quality DV capture via MotoDV (included). MotoDV puts all saved files 

directly into Cleaner’s Batch window to streamline your workflow. For more information, see the 

Capturing Your Source chapter in the Cleaner 5 User Manual or refer to the MotoDV 

documentation on the Cleaner 5 CD-ROM.

Integration with video editing systems
You can now directly export to Cleaner from the latest iFinish and Media 100 i systems, as well as 

certain new Avid systems and Adobe Premiere. See the Integration Guide on the Cleaner 5 CD-

ROM for more information.

Read MPEG-1 & MPEG-2 sources
Cleaner 5 can read any standard MPEG-1 or MPEG-2 bitstream as a source format, which is 

useful for repurposing MPEG streams to Internet streaming formats, such as Quicktime, 

RealSystem and Windows Media. It’s also very useful when working with editing or storage 

systems that use MPEG as their base format. For details, see Appendix A:  Architectures & 

Formats — MPEG in the User Manual.

Improved AVI source compatibility
Cleaner 5 supports the Windows DirectShow architecture to improve compatibility with more 

source files on Windows. Cleaner also now supports video editing systems that produce 

programs as separate AVI and WAV files by automatically connecting the audio and video in the 

Batch window. For more details, see the Working with Batches chapter in the User Manual.
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>2 GB source file support
Cleaner 5 can read files larger than 2 GB, which is helpful for long-form source material. 

Author

EventStream authoring
With Cleaner 5, you can now author EventStreams to add stream navigation, synchronize HTML 

to streaming media, embed “Buy me!” links and interactive hot spots, and more. Because these 

features are supported by the popular streaming architectures — QuickTime, RealSystem and 

Windows Media — no special plug-ins or players are required. For more information, see the 

EventStream Authoring chapter in the User Manual.

EventStream encoding
Cleaner 5 is the only tool that allows you to easily encode your EventStreams into QuickTime, 

RealSystem and Windows Media formats at the same time. The different formats support 

varying levels of functionality, and Cleaner automatically adjusts for each. Cleaner’s unique 

EventStream Editor allows you to author your events once and create multiple outputs without 

having to reauthor, saving you time and hassle. For more information, see the EventStream 

Authoring chapter in the User Manual.

Realtime EventStream marking
With Cleaner’s simple interface, you can place event markers into a movie while you play the 

source in realtime, then later define the details of your EventStream. This helps save time as 

you’re adding events such as URL flips and other time-related markers. See the EventStream 

Authoring chapter in the User Manual for more information.

Media 100 i EventStream authoring
Cleaner 5 is seamlessly integrated with Media 100 i, allowing you to author EventStreams directly 

in the Media 100 i timelines for the ultimate streaming production system. For more 

information, see the Integration Guide on the Cleaner 5 CD-ROM.

Cross-platform settings
Cleaner's settings are now based on XML, which makes them cross-platform and facilitates 

scripting. This is a great help in mixed-platform encoding labs and makes exchanging settings 

via email or the web easy. See the Working with Settings chapter in the User Manual for details.
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Encode

Architectures and Formats

QuickTime
Improved QuickTime support in Cleaner 5 allows you to create MP3-compressed audio tracks in 

QuickTime movies. See Appendix A:  Architectures & Formats — QuickTime in the User 

Manual for more information.

RealSystem
Cleaner 5 offers support for RealSystem 8, including two-pass variable bitrate (VBR) encoding 

and support for the latest RealSystem codecs, to deliver the highest-quality RealMedia files. 

See Appendix A:  Architectures & Formats — RealSystem in the User Manual for more details.

Windows Media
Cleaner 5 supports the latest Windows Media advances, including five-stream Intelligent 

Streaming Windows Media Video files when authoring on Windows (Mac OS encoding options 

were more limited at the time of release). See Appendix A:  Architectures & Formats — 

Windows Media Technologies in the User Manual for more information.

MP3
Cleaner produces the highest-quality MP3 on the market, and Cleaner 5 now creates variable 

bitrate (VBR) files. Cleaner’s MP3 encoding is dramatically faster, which saves you time while 

encoding your audio into archival-quality MP3 files. See Appendix A:  Architectures & Formats 

— MP3 in the User Manual for more details.

MPEG-1
Comprehensive support for MPEG-1 encoding is now available right out of the box with 

Cleaner 5, including batch processing and a wide range of parameter control. If you’ve ever 

wanted to make MPEG-1 for CD-ROM, VideoCD or network distribution, Cleaner 5 offers a 

powerful, upgradeable solution. For more details, see Appendix A:  Architectures & Formats — 

MPEG in the User Manual.

MPEG-2
Basic support for MPEG-2 encoding in both NTSC and PAL formats is also built into the base 

version of Cleaner 5. If you want to produce basic MPEG-2 streams, Cleaner 5 is a great solution. 

If you need to do production work and require more control over MPEG-2 output, Cleaner offers 

two different upgrades for more control and speed. For more information, see the following 

descriptions of Cleaner MPEG Charger and Cleaner MPEG SuperCharger. 
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Cleaner MPEG Charger
This software-only MPEG option adds comprehensive support for MPEG-2 encoding, including 

VBR, and enhances Cleaner 5's MPEG-1 support with one-pass and two-pass VBR encoding. 

Choose Internet > Cleaner Options & Upgrades for more details. 

Cleaner MPEG SuperCharger
This hardware option greatly accelerates MPEG-2 encoding for fast production of high-quality 

MPEG-2 for DVD and network use. Choose Internet > Cleaner Options & Upgrades for more 

information. 

Processing enhancements

Overall speed increase
Cleaner 5 processes files faster than previous versions of Cleaner.

Dual-processor support
Cleaner 5 includes dual-processor support on both Windows and Macintosh for increased 

processing speed. 

Enhanced decoding
Cleaner 5 decodes files significantly faster by using a combination of native YUV processing and 

Digital Origin’s DV codec. Cleaner also offers several decoding options through the Preferences 

dialog that allow you to choose between higher quality or faster decoding. These options can 

improve Cleaner’s performance when decoding certain files, such as MPEG and DV source. For 

more information, see the Streamlining Cleaner Workflow chapter in the User Manual.

Field-based video processing
Cleaner now filters video fields independently, which provides improved video quality with 

interlaced output, such as MPEG-2.

Adaptive deinterlace filter
This new video filter intelligently deinterlaces video sources to give you better-quality final 

output, especially with larger output such as broadband streaming and MPEG files. See the 

Optimizing Your Source chapter in the User Manual for more information.

Improved Adaptive Noise Reduction filter
Cleaner 5’s noise reduction filter is now significantly faster, allowing you to remove unwanted 

noise in less time for better final image quality. For information on this filter, see the Optimizing 

Your Source chapter in the User Manual.
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Temporal Processing
This new option analyzes frames before and after the current frame to remove even more noise 

for superior compressed image quality when using the Adaptive Noise Reduction filter. See the 

Optimizing Your Source chapter in the User Manual for more information.

Improved Dynamic Range audio filter
This important audio filter is now significantly faster so you can use it whenever you need to, not 

just when you have extra time. For more information, see the Optimizing Your Source chapter 

in the User Manual.

Publish

Independent destinations
Unlike previous versions of Cleaner, which required all files in a batch to be placed in a single 

destination folder, Cleaner 5 now allows you to specify a unique destination, either local or 

remote, for each item in a batch. See the Working with Batches chapter in the User Manual for 

more information.

Remote destinations
Cleaner’s StreamPublisher feature allows you to upload files to remote servers, making it easy to 

publish your streams to a hosting service. This is a major workflow improvement, eliminating 

the need for separate FTP software and extra steps. See the Working with Batches chapter in the 

User Manual for more information.

Custom output names
You can now define a custom output file name for items in a batch for superior naming control 

and flexibility. For more details, see the Working with Batches chapter in the User Manual.
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Workflow

Settings modifiers
You can now override base settings with a settings modifier applied in the Project window. This 

saves time and hassle by allowing you to assign a single base setting to a range of files and then 

simply modify aspects unique to each source, such as color correction and filtering, without 

having to create multiple new settings. See the Working with Settings chapter in the User 

Manual for more information.

DCOM automation
You can control Cleaner 5 via DCOM on Windows to build your own custom automated 

encoding solutions. See the Automation Guide on the Cleaner 5 CD-ROM for more 

information.

XML-based Settings
Cleaner 5’s settings are now based on XML, which allows them to be shared between Windows 

and Mac OS, as well as generated by databases to facilitate even greater automation. See the 

Working with Settings chapter in the User Manual for more information.

News & Updates
Cleaner 5 now automatically informs both Windows and Mac OS users about the latest Cleaner 

updates and streaming news, such as new codecs and new versions of the players. This helps you 

stay on top of this rapidly changing industry and ensures you’ve got the latest and greatest 

software and codecs for your streaming media files. See the Streamlining Your Workflow 

chapter in the User Manual for more information.

Terran Interactive EventStream files (.ties)
Cleaner supports Terran's XML-based standard for EventStream interchange. For more 

information, see the EventStream Authoring chapter in the User Manual.

Set In/Out times in settings
You can now specify In/Out times in the Advanced Settings window. This allows you, for 

example, to easily encode only the first 29 seconds of audio for large batches of files. This also 

allows for improved automation solutions because in/out times can be specified via scripting. 

See the Preparing a Project chapter in the User Manual for more information.

“Skip” batch items
This feature allows you to skip items in your batch without removing them completely, which is 

helpful if you want to leave an item in a batch for later processing while working on a different 

item. See the Working with Batches chapter in the User Manual for more information.
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Windows system requirements

• Windows 98/NT4/2000

• Pentium or equivalent processor 

(200 MHz or faster recommended; Single or dual processor supported)

• QuickTime 4.1.2 (included on CD-ROM)

• 96 MB of RAM

• Monitor capable of displaying 800x600 pixels in thousands of colors (16-bit) 

Monitor capable of displaying at least 1024x768 pixels in millions of colors 

(24-bit) recommended

• CD-ROM or DVD-ROM drive

• 10 MB of hard drive space for application 

Mac OS system requirements
• Apple Macintosh computer with a PowerPC processor 

(Single or dual processor supported)

• Mac OS 8.6 or later

• QuickTime 4.1.2 (included on CD-ROM)

• 32 MB of available application RAM with 2 MB available for System

• Monitor capable of displaying 800x600 pixels in thousands of colors (16-bit)

Monitor capable of displaying at least 1024x768 pixels in millions of colors 

(24-bit) recommended

• CD-ROM or DVD-ROM drive

• 10 MB of hard drive space for application
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Windows installation
To install Cleaner on Windows:

1 Insert the Cleaner 5 CD-ROM in your CD drive. If 

Windows’ AutoRun feature is enabled, the installer 

automatically launches. 

2 If you don’t have AutoRun enabled, choose 

Start > Run and launch Setup.exe from the root 

directory of the Cleaner 5 CD-ROM.

3 Follow the on-screen directions. 

4 Read the Software License Agreement. Press the Yes button to signify that you accept the 

terms of this agreement and continue the installation process. If you do not agree to the 

terms of the software license, do not install Cleaner and immediately return the software 

for a refund.

5 Select one of the following installation options:

• Typical for the most commonly needed items to be installed

• Compact for a minimal installation

• Custom to manually specify the items to be installed 

6 Select the program folder and destination hard drive for the installation. 

7 After the installer is finished, launch Cleaner from the Start menu.

Typical install on Windows
The Typical install option puts the following items on your hard drive:

• Cleaner application

• MotoDV application

• Adobe Premiere Export Module (if Premiere is present)

• Various DLLs and other required program resources (including Cleaner-specific Real 

extensions)

NOTE:  The Cleaner Installer will launch the QuickTime Installer once installation of Cleaner 

is complete. Follow the QuickTime Installer’s instructions.

The items installed by the Typical install option take approximately 10 MB of drive space. 

Cleaner 5 installer for Windows.
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The Installer also searches for a Premiere Plug-Ins folder. If it finds one, it places a copy of the 

Cleaner Export Module in that folder. If it doesn’t detect the Premiere Plug-Ins folder, it does not 

install the Export Module. You can also install the Premiere Export Module by performing a 

Custom install. You must restart Premiere prior to using the Export Module.

Compact install on Windows
This option puts the minimum required files on your hard drive. These are:

• Cleaner application

• Various DLLs and other required program resources (including Cleaner-specific Real 

extensions)

Custom install on Windows
Custom lets you control which Typical items are installed.

Uninstalling Cleaner for Windows
If you want to remove Cleaner from your computer, you can do so by choosing 

Start > Programs > Cleaner > Uninstall Cleaner and follow the directions provided. You can 

also use the Add/Remove Programs control panel. The uninstall utility will only remove the 

Cleaner application and its support files; it will not remove your batch files, setting files or 

encoded movies. You can manually delete these files if desired.
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Mac OS Installation
To install Cleaner on a Macintosh computer:

1 Insert the Cleaner 5 CD-ROM into the drive.

2 Double-click the Install Cleaner icon on the 

Cleaner 5 CD-ROM and follow the on-screen 

directions. 

3 Read the information in the ReadMe and the 

Software License Agreement. Press the Agree 

button to signify that you accept the terms of 

this agreement and continue the installation process. If you do not agree to the terms of the 

software license, do not install Cleaner and immediately return the software for a refund.

4 The installer defaults to the Easy Install option. Select Custom Install to manually specify 

the items to be installed.

5 Select the destination hard drive.

6 Press the Install button to begin installation.

7 Restart your computer.

Easy Install on Mac OS
The Easy Install option installs the following items on your hard drive:

• Cleaner application

• Cleaner 5 support files (including RealSystem and Windows Media extensions)

• Adobe Premiere Export Module (if Premiere is installed)

The items installed by the Easy Install option take approximately 10 MB of hard drive space. 

The Installer searches for a Premiere Plug-Ins folder. If it finds one, it places a copy of the Cleaner 

Export Module in that folder. If it doesn’t detect the Premiere Plug-Ins folder, it does not install 

the Export Module. You must restart Premiere prior to using the Export Module.

Custom Install on Mac OS
Choosing the Custom Install option allows you to control which of the items from the Easy 

Install option described previously are installed, including  the Premiere Export Module.You can 

also install Digital Origin’s MotoDV using the Custom Install option. See Installing MotoDV on 

page 15 for more information.

Cleaner 5 installer for Mac OS.
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To launch Cleaner after installation, restart your computer, open the Cleaner 5 folder on your 

hard drive and double-click the Cleaner 5 application.

Installing MotoDV
The Cleaner 5 Installer also includes Digital Origin’s MotoDV for capturing video directly into 

Cleaner. On Windows, MotoDV installs automatically as part of the Typical Install. On Mac OS, 

you must use the Custom Install option in the Cleaner 5 Installer and check the MotoDV option 

to install it to your hard drive.

On Mac OS, a warning dialog appears before MotoDV 

is installed informing you that MotoDV’s high-

performance FireWire software will not work with 

Final Cut Pro, iMovie or Adobe Premiere. If you are 

using any of these applications, you can either 

manually disable the conflicting drivers, or you can run  

the Choose FireWire Support application on the 

Cleaner 5 CD-ROM, which can do this for you 

automatically.

To use the Choose FireWire Support application:

1 Double-click on the application.

2 Press either the Use QuickTime button or the Use 

MotoDV button. If you are using Final Cut Pro, 

iMovie, or Adobe Premiere, you should choose 

Use QuickTime. This enables only Apple’s built-in 

FireWire drivers. If you are using MotoDV, 

EditDV or any other Digital Origin product, 

choose Use MotoDV to enable Digital Origin’s 

FireWire drivers.

3 Press the Quit button and restart your computer. 

Your computer’s FireWire support is now properly 

configured to your applications.

On Mac OS, you need to disable
MotoDV’s drivers in order to use it with
Final Cut Pro, iMovie or Adobe Premiere.

Choose the FireWire software based on
which editing applications you’re using. 
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Installing QuickTime
The Cleaner Installer automatically launches the QuickTime Installer once installation of 

Cleaner is complete. This installs both the authoring components and QuickTime player. Please 

follow the QuickTime Installer’s instructions. For more details, see the QuickTime 

documentation on the Cleaner 5 CD-ROM. You can also download the latest QuickTime 

installer from www.apple.com/quicktime/.

If you choose the Custom option when installing Cleaner, the QuickTime Installer may not be 

launched. If you want to install QuickTime in this case, you can simply run the QuickTime 

installer separately by launching it from the Cleaner 5 CD-ROM. 

NOTE:  Cleaner 5 requires QuickTime 4.1.2 or later. Please verify that you have QuickTime 

properly installed prior to launching Cleaner.

Installing RealSystem
To encode Real files with Cleaner, you must have the proper RealSystem encoder components 

installed in your system.

• On Windows, the Typical or Compact install places the components you need for encoding 

in a Cleaner Support folder in the System folder.

• On Mac OS, the Easy Install places the components in a Cleaner Support folder, which 

resides in the Extensions folder of your System folder.

To play Real files, you must install the RealPlayer. You can download the latest free version of the 

RealPlayer from Real’s site at www.real.com/.

Installing Windows Media
To encode Windows Media, you must have the Windows Media components installed. 

• On Windows, the Typical or Compact install places the components you need for encoding 

in the Windows System Directory in the System folder. On Windows 95/98, this folder is 

usually located in C:\WINDOWS\SYSTEM. On Windows NT 4/2000, this folder is usually 

located in C:\WINNT\SYSTEM32.

• On Mac OS, the Easy Install places the Windows Media components in the Extensions 

folder of your System folder.

To play Windows Media files, you must install the Windows Media Player. You can download the 

latest version of this player from Microsoft’s site at www.microsoft.com/windows/mediaplayer/.
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Installing the Premiere Export Module
If the Cleaner 5 Installer is able to locate a Premiere Plug-Ins folder during a Typical install on 

Windows or Easy Install on Mac OS, it will install the Premiere Export Module.You can also 

install the Premiere Export Module by performing a Custom Install. For information on using 

Premiere with Cleaner, see the Cleaner Integration Guide on the Cleaner 5 CD-ROM.

Personalizing Cleaner
The first time you launch Cleaner 5, it checks to see if you already have a prior version of Cleaner 

installed. If so, it uses your previous serial number and converts your older settings to the 

Cleaner 5 setting format. 

If Cleaner 5 doesn’t find a previously registered version of Cleaner, it asks for your activation key, 

name and company. For new copies of Cleaner, the activation key is located on a sticker attached 

to the title page of the User Manual. 

If you purchased the Cleaner 5 upgrade, use your previous Cleaner serial number. If you have 

any trouble with your activation key, see Appendix C:  Troubleshooting in the User Manual for 

the best ways to contact us.

After you enter your activation key, Cleaner asks if you want to use the Settings Wizard or the 

Advanced Settings as the default for working with settings. If you are new to streaming media, we 

suggest you start with the Wizard. For more experienced users, the Advanced Settings provide 

total control over setting parameters. You can always switch between the Settings Wizard and 

Advanced Settings by pressing the Use Wizard or Advanced Settings button at the bottom of 

the settings windows.

News & Updates
Cleaner’s News & Updates feature helps keep you up to 

date on the rapid changes in streaming media. This 

feature notifies you of new versions of Cleaner, new 

codecs, player updates and other important 

information. 

When you first launch Cleaner, and occasionally 

afterwards, a dialog may appear to inform you of new 

events, releases, updates, etc. See the Streamlining 

Cleaner Workflow chapter in the User Manual for more 

information. 

News & Updates notifies you 
of new developments and releases.

Together, Cleaner 5 and Cleaner MPEG SuperCharger form
the ultimate MPEG-2 encoding solution. SuperCharger allows
you to create outstanding MPEG-2 fast.

Supercharge your MPEG-2
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Don’t forget to register! 
Please take a moment to register your copy of Cleaner. Registering helps us keep you informed 

about free updates to Cleaner and is required to receive technical support. Simply choose 

Internet > Register My Product to register at Terran’s website. 
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This chapter gives you a quick overview of how to produce streaming video with Cleaner. If 

you’re new to Cleaner, we recommend that you refer to the Cleaner 5 Tutorial on the Cleaner 5 

CD-ROM to learn more about how to use Cleaner. You may also find it helpful to read General 

Cleaner concepts & terms on page 25 of this booklet to better understand the terminology used 

in this chapter.

In the context of Cleaner, the production process is normally comprised of four steps: 

Capture, Author, Encode and Publish. 

Capture
Before you can begin encoding files with Cleaner, you need to capture your video. Capturing 

involves transferring your video from your camera onto your computer’s hard drive. Cleaner 

includes Digital Origin’s MotoDV software to make capturing DV files easy. Since Cleaner also 

reads a wide variety of video and audio formats, you can also use it to process previously 

captured material, such as AVI, MPEG and QuickTime. For information on the files Cleaner can 

read, see Appendix A:  Architectures & Formats — Formats supported in the User Manual.

If you have already captured your video on your hard drive, you can skip the following steps and 

simply launch Cleaner and drag the file onto Cleaner’s Batch window. If you don’t have a DV 

camera, you can skip the following steps and simply use one of the tutorial movies on the 

Cleaner 5 CD-ROM in the Tutorial folder.

To capture video using MotoDV:

1 Connect your camera to your computer via the IEEE 1394 

(FireWire, i.Link) port. If you do not have an IEEE 1394 port, 

you can purchase a MotoDV-compatible card directly from 

Terran. See Internet > Cleaner Options & Upgrades for 

more information.

2 Launch Cleaner 5 and choose File > Capture DV to Batch.  

This launches MotoDV.

3 Set your DV camera to VCR mode. MotoDV’s remote control 

keyboard should be visible in the MotoDV application.

Choose Capture DV to Batch
in Cleaner’s File menu
to launch MotoDV.
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4 Press the keypad’s Play button to start the tape. Your footage 

should be visible in MotoDV’s Preview window.

5 Press the Capture button when you want to start capturing. 

Press the Stop button when you want to stop.

6 Specify a name for your clip in the dialog box that appears and 

press the Save button. The clip is automatically added to 

Cleaner’s Batch window for processing. For more details, see 

the Capturing Your Source chapter in the User Manual.

7 In Cleaner’s Batch window, double-click on the source file name or icon in the Project 

column. Doing so opens the Project window.

8 Click and drag on the image to crop the video to the area you specify. This is helpful if your 

video has black edges. See the Preparing a Project chapter in the User Manual for more 

information.

9 If you need to trim your movie, step through the movie 

using the movie controller or the arrow keys to the 

frame you want to use for the In point.

10 Press Ctrl+[ / "+[ (left bracket) or choose Edit > Set In Point. The yellow bar under the 

movie controller will change to reflect the new In point, which is designated by a green dot.

11 Use the movie controller to select the Out point.

12 Press Ctrl+] / "+] (right bracket) or choose Edit > Set Out Point. The yellow bar under 

the movie controller changes to reflect the new Out point, which is designated by a red dot.

In MotoDV, press Play
to view your source tape.

Drag the movie controller or use
the arrow keys to set the In point.
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Author
Cleaner allows you to author rich-media elements in your QuickTime, RealSystem and Windows 

Media streams, such as interactivity, URL flips, links to sites, chapter lists and caption tracks. 

The range of features depends on the output format. See the EventStream Authoring chapter in 

the User Manual for more details.

To add EventStream interactivity or features to your stream:

1 Press the Edit button in the EventStream panel at the 

bottom of the Project window. The EventStream Editor 

appears.

2 In the Project window, use the movie controller to find a 

point where you want to add an event, such as a URL link, 

and press the Add button. You can also add events in 

realtime by playing the movie in the Project window and 

pressing Ctrl+M / "+M to add markers that you can later 

define in the EventStream Editor.

3 In the EventStream Editor, use the pop-up menu on the left 

to select an event, such as a URL link. For more 

information on EventStreams, see the EventStream 

Authoring chapter in the User Manual.

4 Close the Project window and EventStream Editor when you are finished.

Encode
Encoding is the process of turning your original sources into streaming files in formats such as 

QuickTime, RealSystem and Windows Media. You have many options when encoding files and 

you can use either the Settings Wizard or Advanced Settings window to choose your desired 

parameters. 

In these settings dialogs, Cleaner also gives you access to many processing options to improve 

your final streams, such as video and audio filters, image adjustments and codecs. For more 

information on settings, see the Working with Settings chapter in the User Manual.

Use the EventStream Editor
to author rich-media files.
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To choose a setting;

1 Double-click on the Setting column of the project. Depending on what you chose in the 

Welcome dialog when you installed Cleaner, the Settings Wizard or Advanced Settings 

window appears. If you are new to streaming media, we recommend that you use the 

Wizard to guide you through the process. If you need to switch modes, press either the 

Advanced Settings or Use Wizard button at the bottom of the window. Or, choose 

Windows > Advanced Settings or Windows > Settings Wizard.

2 If you are using the Settings Wizard, answer the interview questions and press the Apply 

button to return to the Batch window. 

3 If you are using the Advanced Settings 

window, choose an existing setting on the left 

side of the window. You can modify the 

setting in the Advanced Settings tabs on the 

right side of the window. The Dynamic 

Preview window allows you to preview the 

effects of your setting by choosing 

Windows > Dynamic Preview 

(Ctrl+D/"+D). When you finish modifying 

your setting, press the Apply button to return 

to the Batch window. 

Publish
Cleaner’s StreamPublisher feature allows you to either save your encoded files to your hard drive 

or publish them to a streaming server or hosting service. If you don’t choose a custom 

destination for your files, Cleaner prompts you for a location on Mac OS or uses your My 

Documents folder on Windows. For more information on this feature, see Specifying the 

default destination on page 36 of the Cleaner 5 manual.

To specify a destination:

1 To specify a custom destination for your final streams, including a remote server, double-

click the Destination column in the Batch window.

2 In the Custom Destination dialog that appears, select an existing destination from the list 

or create a new destination by pressing the Add button.

If you are creating streaming movies, you must specify your streaming server location so 

that Cleaner can generate the proper reference files. If prompted, enter the server path to 

your streaming server in the dialog provided. You can also specify the streaming server 

path by choosing Edit > Preferences and entering this information in the fields provided.

The Advanced Settings window lets you
manually select encoding parameters.
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3 Press the Start button to begin encoding. Cleaner encodes 

your files, saves and/or uploads them to the destinations you 

specified and chimes when it is finished. If your setting has 

specified it, Cleaner also creates the HTML code for 

including your file in your web page. These are placed in the 

same folder as the final encoded movie. You can also set 

Cleaner to create metafiles (RAM, WVX, WAX files) for 

your streaming movies. The metafiles should be uploaded 

directly to your HTTP server.

4 If you have encoded a movie in a format that Cleaner can 

display, such as a QuickTime movie, you can view it in the 

Output window that remains after the encoding is finished. 

If you have encoded a different format, use the appropriate 

media player, such as RealPlayer or Windows Media Player, 

to view your finished file.

Select a folder or a server
for your final encoded files.
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This chapter outlines some of the basic concepts and aspects of working with Cleaner and streaming 

media. Understanding this information will help you understand how to use Cleaner more effectively.

General Cleaner concepts & terms
Encoding — The process of changing files from their original format, such as QuickTime or 

Video for Windows, into files ready for distribution, such as streaming QuickTime, RealSystem, 

Windows Media and MPEG, is called encoding. There are many encoding parameters that you 

can set, such as the codec, bitrate, frame rate and quality settings. 

Processing — Within Cleaner, there are many operations that can be performed in addition to 

encoding files, such as cropping, scaling, applying video filters and adjusting the video and audio 

levels, to help to produce the highest-quality results. Together, these operations and encoding are 

often referred to as processing your files. 

Setting — Cleaner lets you save the encoding and general processing parameters you apply to a file 

as a group, called a setting. This makes it easy to assign these parameters to other files you want to 

process in the same fashion. You can manually configure your settings in the Advanced Settings 

window or get help from the Settings Wizard. Cleaner’s Dynamic Preview feature helps you fine 

tune your parameters while you create settings.

Project — A project is comprised of a source file and all the processing details associated with it. 

Each row in the Batch window represents a project. A typical project includes the source file, 

cropping information, In/Out points, EventStream markers, the base setting assigned to the file, 

any settings modifiers used to alter the base setting, an optional processing priority and a 

destination for the final file.

Batch — A batch is a group of projects. Cleaner makes processing many projects easy — you can 

drag and drop up to 2,000 source files directly onto the Batch window and quickly assign settings, 

destinations and other processing options. The list in the Batch window that contains the files, their 

settings, unique cropping and In/Out points is called a batch. Batches can be saved for future use.

EventStream — All the major streaming formats offer some level of interactivity or special 

features. Cleaner’s EventStream authoring allows you to access these features to create stream 



26 Introduction to Cleaner   Cleaner 5 Basics
navigation, synchronize HTML to streaming media, embed links and interactive hot spots, and 

add text tracks for inclusion in your streams.

Cleaner 5’s interface 
This section gives you a brief overview of the functions of the interface elements in Cleaner 5, 

and refers you to the chapters in the User Manual if you want to learn more details.

Understanding the basics of Cleaner’s interface is a good place to start when learning how to use 

Cleaner efficiently.

Batch window
Cleaner’s streamlined interface makes it easy to control 

the encoding process. The Batch window is the “home 

base” for encoding. You see a list of your projects in this 

window and can open the Project window by double-

clicking on the Project column. You can also set the 

destination and priority of items in the batch.

From the Batch window, you can start, stop and pause 

encoding using the buttons at the bottom of the 

window. The Batch window displays essential 

information regarding file names, status and settings 

here. An information section appears at the bottom of 

the window which gives you directions as you use 

Cleaner.

For more information, see the Working with Batches chapter in the User Manual.

The Batch window is the “home base”
for processing.
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Project window
The Project window displays your original source file. If 

your file is a movie, you can play the original in this 

window, as well as view the data rate and frame size 

graph. More information, such as settings modifiers, 

EventStream summary and destination information, is 

listed in the panels below the data. 

You can set the cropping and the In/Out points in the 

Project window. 

Output window
The Output window lets you monitor the progress of 

the project being processed and displays the final 

encoded file. As with the Project window, a data rate 

graph and frame size graph are available under the 

window, as well as encoding information. 

Cleaner can’t currently display all the formats it 

produces in the Output window. See Opening output 

movies with HelperApps on page 134 of the Cleaner 5 

manual for details on using the HelperApps feature on 

Mac OS to open unsupported formats with the various 

player programs.

While you are encoding a movie to certain formats, 

such as QuickTime, a Before/After slider appears to let 

you compare the original and the final encoded file. 

For more information, see the Working with Batches 

chapter in the User Manual.

The Project window gives you
information about your file and access
to modify settings and EventStreams.

The Output window monitors the file’s
progress and has a Before/After slider 
to compare the original to the 
encoded file. 
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Settings Wizard 
The Settings Wizard interviews you and creates settings 

based on your responses to the questions. 

If you are a beginning user, the Wizard is an excellent 

way to get started with encoding. You don’t need to 

know technical details such as data rates, keyframe 

frequency or codec choice to get great results. 

For more information, see the Working with Settings 

chapter in the User Manual.

Advanced Settings
The Advanced Settings window gives you access to all 

the processing parameters, such as codec selection, 

image size, audio rates, A/V fades and keyframe 

settings.

The list on the left shows all the available settings, and 

the tabs on the right let you configure your settings. 

Manage your settings with the buttons next to the list. 

For more information, see the Working with Settings 

chapter in the User Manual.

Dynamic Preview
When using the Settings Wizard or Advanced Settings 

window, you can use the Dynamic Preview to see how 

your parameters affect your source file. To open the 

Dynamic Preview window, choose Windows > 

Dynamic Preview (Ctrl+D / """"+D).

Each side of the Dynamic Preview has a Process and an 

Encode checkbox that let you specify what is displayed 

on that side of the preview. Like the Before/After slider, 

the Dynamic Preview slider can be moved back and 

forth to show the difference between the original image 

and the processed and/or encoded image.

See the Choosing & Previewing Encoding 

Parameters chapter in the User Manual for details.

The Settings Wizard interviews you 
to help configure your settings.

The Advanced Settings window lets you 
manually select and configure your 
setting parameters. 

The Dynamic Preview shows the effects
of your processing and.or encoding
parameters.
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Settings Modifiers
You can modify aspects of the setting assigned to a 

source file without having to create an entirely new 

setting by using the Settings Modifiers window. This is 

very useful if you have a batch of files that you want to 

encode the same way, but need to change a few settings 

for a specific movie, such as adjusting the brightness for 

a dark source or applying stronger video filtering for a 

noisy source. Settings modifiers apply only to the 

currently selected project and are not savable.

The Settings Modifiers window is accessed by first 

opening the Project window for a given source file, then 

pressing the Edit button in the Settings Modifiers & 

Metadata panel at the bottom of the Project window. 

The Settings Modifiers window looks very similar to the 

Advanced Settings window without the setting list. 

Simply choose the parameters you want to modify from 

the available tabs and press the Apply button. 

Any option you change in the Settings Modifiers window will be used instead of the 

corresponding option set in the base setting created with either the Settings Wizard or Advanced 

Setting window. 

For more information, see the Working with Settings chapter in the User Manual.

Metadata
The Metadata tab in the Settings Modifiers and 

Advanced Settings windows lets you attach additional 

information to the movie you are creating, such as the 

title, author and copyright. The type of information the 

viewer sees depends on the format of the file and the 

player application used to view the file.

For more information, see the Working with Settings 

chapter in the User Manual.

Settings Modifiers let you change 
specific aspects of a file’s base 
setting without affecting the rest
of the batch.

You can access the Metadata tab
via the Settings Modifiers or
the Advanced Settings window.
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EventStream Editor
The EventStream Editor lets you assign events to your 

streaming files to add navigation, synchronize HTML to 

streaming media, embed links and interactive hotspots 

and more. 

To add an EventStream to your project: 

1 Open the Project window and select a spot in the 

source file where you want the EventStream to begin.

2 Press the Edit button in the EventStream panel of the 

Project window to open the EventStream Editor. 

3 Press the Add button in the EventStream editor and 

use the pop-up menu to choose an event to add to the 

file. You can add a descriptive label in the Label field 

to help you identify each event listed in the 

EventStream Editor list, and you can export your event list to use with other files.

For more information, see the EventStream Authoring chapter in the User Manual.

StreamPublisher
Cleaner’s StreamPublisher feature lets you upload your 

files directly to a remote streaming server or save them in 

a local folder on your hard drive after the file is encoded. 

You can also use this feature to put specific files into a 

custom destination, instead of the default destination, 

and set custom file names. 

To use the StreamPublisher:

1 Double-click on the project’s Destination column in 

the Batch window to open the Destinations dialog. 

2 Use the radio buttons provided to select a 

destination. This can either be a folder on your hard 

drive or a server. 

3 To define a new destination, press the Add button 

and either choose a path or enter the server information in the dialog provided. We 

recommend you enter a descriptive name for the directory in the Label field. You can also 

edit and remove destinations with the buttons in this window.

For more information, see the Publishing Your Files chapter in the User Manual.

The EventStream Editor lets you
specify interactive events, such as
URL flips and hotspots. 

The Destinations dialog lets you
specify destinations for files, including 
FTP or streaming servers. 
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Preferences dialog
The Preferences dialog lets you control various aspects 

of the Cleaner application, such as the data rate units, 

decoding speed and streaming server paths. Choose 

Edit > Preferences to open the Preferences dialog.

For more information, see the Streamlining Cleaner 

Workflow chapter in the User Manual.

You can alter many aspects of Cleaner
in the Preferences dialog.
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What is streaming?
The term streaming has become fairly broad in definition and now generally refers to media, 

such as video and audio, that is delivered over a network. Often this term has a more specific 

connotation for movies that are delivered to personal computers over the Internet. 

There are two common approaches to streaming today:  Realtime streaming and progressive 

streaming. Generally, if a video is being broadcast live or a streaming media server or protocol is 

used, such as RTSP (realtime streaming protocol), it is realtime streaming. If an HTTP server is 

used, the file is being delivered via progressive streaming. 

Cleaner also supports files that must be downloaded entirely to the hard drive before they can be 

played. Downloadable files are common practice for MP3 and MPEG files, but can also be used 

for RealSystem and Windows Media files.

Choosing a streaming method
Which delivery method is right for your project depends on your needs. A brief discussion of 

each method follows. Drop by Codec Central by choosing Internet > Codec Central for samples 

of movies delivered by both methods. 

Windows Media and RealSystem only support realtime streaming; QuickTime supports 

delivering files via both realtime streaming and progressive streaming. For optimal results, you 

should prepare your movie specifically for the delivery method you decide to use. 

Progressive streaming
Progressive streaming, also known as progressive download, refers to online media that users 

can watch as the files are downloaded. The user can see the part of the file that has downloaded at 

a given time, but can’t jump ahead to portions that haven’t been transferred yet. Progressive 

streaming files don’t adjust during transmission to match the bandwidth of the user’s connection 

like a realtime streaming format. Progressive streaming is often called HTTP streaming because 

standard HTTP servers can deliver files in this fashion and no special protocols are needed. 

QuickTime’s fast start feature is an example of a progressive streaming technology. 
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Progressive streaming delivery is well suited to short movies that you want to be viewed at high 

quality, such as movie trailers and product advertisements. This method guarantees the quality 

of the final movie because the viewed portion of the file is losslessly downloaded before it is 

played. This means users may experience a delay before the movie starts, especially with slower 

connections. 

Progressive streaming is especially useful for modem delivery of short pieces because it lets you 

create a movie with a higher data rate than a modem could stream in realtime. Although doing 

this causes the viewer some delay, it also allows you to present a much higher-quality movie. 

Because progressive streaming material is placed on a standard HTTP or FTP server, it is easier to 

administer, and there generally aren’t any problems with firewalls. 

Progressive streaming is not a good solution for long movies or material the user may want to 

randomly access, such as lectures, speeches or presentations. Progressive streaming technologies 

also don’t work for material that must be broadcast live — it is strictly an on-demand technology.

Realtime streaming
Realtime streaming refers to technologies that keep the bandwidth of the media signal matched 

to that of the viewer’s connection so that the media is always seen in realtime. The word realtime 

differentiates this type of streaming from HTTP streaming delivery. Dedicated streaming media 

servers and streaming protocols are required to enable realtime streaming. RealSystem, 

Windows Media and QuickTime all offer realtime streaming capabilities.

Realtime streaming delivery always happens in realtime, so it is well suited to live events. It also 

supports random access of material, so the user can fast forward to other parts of the movie, which 

may be useful for presentations and lectures. In theory, realtime streaming movies should never 

pause once they start playing, but in reality, periodic pauses may occur. 

Realtime streaming movies must match the bandwidth of the viewer’s connection, which means 

the image quality is generally poor at modem speeds. Also, information that is lost in the 

network due to errors is often ignored, so the video quality will suffer if the network is congested 

or having problems. If you want to guarantee the quality of the final movie, progressive 

streaming delivery may be a better solution. 

Realtime streaming media requires special servers, such as a QuickTime Streaming Server, a 

RealServer or a Windows Media Server. These servers give you a greater level of control over your 

media delivery but can be more complicated to set up and administer than a standard HTTP 

server. Also, realtime streaming uses special network protocols, such as RTSP (Realtime 

Streaming Protocol) or MMS (Microsoft Media Server). These protocols can sometimes have 

trouble with firewalls, so certain viewers may not be able to see realtime streaming material from 

certain locations.
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Architectures and codecs
As far as a computer is concerned, the two most important aspects of working with streaming 

media are: 

• Synchronizing, managing and playing media

• Making both the video and audio components small enough to play properly on a 

computer or through a network connection while storing the file in a manageable amount 

of space

To effectively handle these tasks, two special 

types of technology were developed: 

streaming architectures and codecs.

Architectures provide the overall structure and 

synchronization for media delivery. Codecs are 

the smaller encoding components that fit within 

an architecture. For example, QuickTime and 

Windows Media are architectures, Sorenson 

Video and MPEG-4 are video codecs, and 

QDesign, RealAudio and WMA are audio codecs. 

Architectures
Multimedia architectures address the first issue of handling and synchronizing digital video files. 

Cleaner supports QuickTime, Real and Windows Media architectures. Cleaner also supports 

MPEG, a standard file format and set of encoding algorithms that is very similar to a streaming 

architecture.

Architectures are often called formats, which is misleading. Formats are the file structures an 

architecture creates with its codecs, such as a QuickTime Movie or a Windows Media Video. 

Besides, an architecture is much more than just a format. For example, QuickTime controls how 

streaming media is handled by the computer, including file conversions, how movies are 

displayed on the screen, and much more. 

Although the various architectures have a lot in common, there are also quite a few differences 

between them. Some are dedicated to playback via the web, others are better for CD-ROM and 

many work best on a specific range of computers. There is no one “best” architecture; choosing 

among them depends on your needs.

For more information, see Appendix A:  Architectures & Formats in the User Manual.

Cinepak QDesign

Streaming 

Codecs

Architecture

Streaming 

Sorenson
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Codecs
Codecs handle the second issue by making movies small enough to play properly on your 

computer or through your network connection while storing the file in a manageable amount of 

space. A codec, short for compressor/decompressor, is the actual encoding/decoding algorithm. 

For example, Sorenson Video is primarily a QuickTime web video codec, while Cinepak is an 

older cross-architecture codec that was commonly used for CD-ROM projects. Some codecs are 

available within several different architectures. For example, there is both a QuickTime and an 

AVI version of Cinepak. 

 

Although the core encoding algorithms may be the same with some cross-architecture codecs, 

files made by different architectures may or may not be interchangeable. For example, a 

QuickTime movie made with Cinepak won’t play under Video for Windows. However, 

QuickTime can play AVI files, provided that these files are encoded with a codec also supported 

by QuickTime, such as Cinepak.

There are also several audio-specific codecs available, including RealAudio, Windows Media 

Audio, QDesign Music and MP3. Audio codecs tend to be geared towards a specific architecture, 

such as RealAudio and Windows Media Audio, but there are also cross-architecture codecs,  such 

as IMA, that work with both QuickTime and AVI files.

For more on architectures and codecs, see Codec Central at www.CodecCentral.com or choose 

Internet > Codec Central.

Choosing architectures and codecs
Selecting the best technologies for a project is a two-step process. 

1 Determine which architecture best meets your needs. See Codec Central for the pros, cons 

and details of each architecture.

For example, if you are making a cross-platform CD-ROM title, QuickTime is probably 

your best choice because it is used on the majority of CD-ROM titles. If you are placing 

realtime streaming video on your website, you can use QuickTime, RealSystem or 

Windows Media — each has advantages and disadvantages. If you are making a 

DVD-Video or Video CD, you need to use MPEG.

2 Select the best codec for your needs. The architecture you choose dictates which codecs you 

can use, and many of the new streaming architectures only have a few choices. Not all 

codecs are available for every architecture. QuickTime offers optional, professional codecs 

that can be purchased to provide additional encoding options. Choose Internet > Cleaner 

Options & Upgrades for more information.

http://www.CodecCentral.com
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Overview of codecs
Video in its raw form takes up huge amounts of space. For example, one second of uncompressed 

NTSC video takes about 27 megabytes (MB) of disk space. To make streaming media possible, 

video encoding algorithms were created. Encoding involves reducing a large movie file in size by 

removing redundant audio and video data. For more dramatic size reduction, less important 

data can also be removed, resulting in image and/or sound degradation.

The codec is the algorithm that handles the encoding of your video or audio, as well as the 

decoding when it is played.

How video codecs work
Most codecs encode the data using spatial and/or temporal encoding techniques to remove 

redundant data. A very basic overview of encoding methods follows. 

Spatial encoding
Spatial encoding removes the redundant data 

within a given image. For example, in the movie 

on the right, there are large areas of flat color with 

many identical pixels (highlighted in white to 

illustrate). 

Instead of specifying each pixel and its color, a 

codec specifies the coordinates of the area and 

the area’s color; it doesn’t note all the little details.

The less detail there is in the image, the better the 

codec is able to generalize the image and encode 

it. Removing fine details in preprocessing can 

improve the spatial encoding of an image. Video 

noise often looks like fine detail to a codec and should be removed to improve spatial encoding. 

Creating video with simple backgrounds also improves how well the final movie encodes.

The highlighted sections have very little detail 
and can be spatially encoded.
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Temporal encoding
Another way to make a frame smaller is to look for changes between consecutive frames and only 

store the differences instead of the entire image. The original reference frame that these 

differences are based on is called a keyframe. Keyframes contain the entire image and look just 

like a normal picture. 

The frames based on the changes between frames are called delta frames or difference frames. 

They contain only information for the areas that are different from the last frame and are usually 

smaller than the keyframes.

The first frame of the movie is a keyframe and contains the entire image. After the initial 

keyframe, a series of delta frames follow. These delta frames show only the differences between 

the previous frame and the current frame. Most of this delta data relates to how the pixels in the 

subject’s face and hands are different from the last frame. 

The delta frame doesn’t contain information 

on the static background because it always 

remains the same as it was in the previous 

frame. Every second or so, a new keyframe is 

used to correct for slight cumulative errors in 

the delta frames.

This kind of encoding tracks data over a 

period of time and is therefore called temporal encoding. Video content that changes very little 

from frame to frame is best suited for temporal encoding. Whenever possible, you should use a 

tripod when filming video for desktop playback and attempt to reduce camera and subject 

movement. This minimizes the differences between frames and can improve the final encoding.

NOTE:  Many of the new streaming codecs are able to detect moderate camera motion and 

compensate for pans. However, using a tripod and maintaining smooth camera motion with 

these codecs always produces better image quality than hand-held camera work.

Codecs in action
The actual process of analyzing each frame and creating an encoded version is the most time-

consuming aspect of video encoding. For each frame, vast numbers of mathematical calculations 

are made to generate the final encoded frame. 

The codec also decompresses the encoded video. The decoding routines are usually much faster 

than the encoding routines. This allows the frames to be decoded fast enough to play in realtime. 

A frame that takes a few seconds to encode might take less than 1/30th of a second to decode. 

Keyframe     Delta       Delta        Delta     Keyframe   Delta

Delta frames show the changes between frames.
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Codecs that take a long time to encode but decode quickly are known as asymmetric. For 

example, the Sorenson Video codec is extremely asymmetric. Movies made with Sorenson Video 

take a long time to create but decode in realtime and play smoothly. 

Codecs that are intended for live broadcasts and video teleconferencing are fairly symmetric, 

meaning they both encode and decode in the same amount of time. H.263 is an example of a 

symmetric codec.

Additional information
For a brief discussion of the various codecs within each architecture, see Appendix A: 

Architectures & Formats in the User Manual. To learn more details about the various codecs and 

see video samples, visit Codec Central by choosing Internet > Codec Central. 
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